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1. Workflow to Add Custom Module (Issue Slip)

You can create a custom module (Issue Slip) in RACE for the mWorkOrder application without any
dependency on coding. The following topics helps you understand how to; create a new custom
module, add screens, add elements, define fields, and call services to display data in the application.

The following workflow makes you understand the structure of the new custom module.

e Module: It indicates the module in the application (for e.g., Issue Slip).

o Floor Plans: It indicates the screens inside the module (for e.g., List screen, Details screen,

Search screen, etc.).

o Sections of Floor Plan: It indicates the sections inside the screens (for e.g., Header, Footer,

Body, Navigation bar, etc.).

Component: It indicates the components inside the sections (for e.g., buttons, icons, etc.).

¢ Elements: It indicates the elements (for e.g., Home icon, Save button, etc.).
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1.1. Requirements
Following are the requirements to create a module:

e Create a module and screens based on the design

e Add tabs and buttons inside the screens

o Add list view and display line item details when tapped on the line item
e Add create button and extensions to create the data by filling fields

e Add save or submit button to post the data

e (Call services to display the posted data in the application
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2. Create Master Data

Create master data for Modules and Screens and use the data during Scoping ID and Screen
configurations.

Use the Modules and Screens menu to create master data.
To create master data:
1. Click Modules and Screens on the left panel.

==
Click the Create button next to the search field.
In the Create Modules & Screens section, enter ISSUESLIP in the Module Name field.
Enter or select the screen name in the Screen Name field.
Enter a short description in the Module Description field.
Click Create.
Select the Customizing Request in the Assign Transport Request window.
Click Submit.

ONOOAWDN

3. Create Issue Slip Module

Create a new module based on the requirement with the help of BA. Fetch the data mentioned in the
BADI and RFC name accordingly. Use the Scoping menu to add Issue Slip module.

To create Issue Slip module:

1. Click Scoping on the left panel.

==
2. Click the Create button next to the search field.

3. Inthe Create Scoping section, enter the following information.

Field Description

Type Type of the feature/module:

e Custom: New feature can be added in the application. You can
add the entries under custom category with or without using the

templates.
System ID Indicates the SAP system like ECC, CRM, SRM to retrieve tables, fields,
and BAPIs list in other screens like Defaults, Extensions.
Module Name Enter/select the name to define/identify the module. For example,
ISSUESLIP.

NOTE: To select the Module Name, create a module name as ISSUESLIP
first in the Modules and Screens section. For more information, Error! R
eference source not found. You can create master data such as
Modules and Screens and use the data during Scoping ID and Screen
configurations.
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4.

3.1

Field

Description

App ID

Unique identity (alpha numeric) to specify the ID for the application. For
example, OPRDS.

Parent App ID

Parent App ID of the module for which the Module is the sub-module.

BOR Object ID

Business object ID based on the transaction codes used for the
configuration process.

Description

Description of the module/feature.

Sequence No

Defines the sequence or position of the screen for the Module.

Title Title of the feature. This title appears in the application as a
module/feature name.
Action Select the type of the action:
e Create: To add a create section.
e Search: To add a search section.
e Display: To add a display section.
Style Select the required icon and styles for the module.
Active To show/hide the module/feature in the mobile application.

Access Category

Enable/disable extension field based on user access:

e T-Transaction Code

e U-User Group

e R-Role

e A-Authorization Object.

Access Value

This field is used for data related to security. Based on the access
category, data in this field needs to be maintained. For example, if you
maintain a transaction code in the Access Category field then you must
enter the t-code name in this field. Module/feature is displayed in the
mobile application only if the user has access to the transaction code.

Click Create.

Enable Issue Slip Module

Enable the module if it is already created. Use Scoping feature to enable the module.

To enable the Issue Slip module:

1.
2.

aoprw

Click Scoping on the left panel.
Enter the App ID or name as Work Orders in the search field.
You can also select the module name in the Module field and filter the App IDs.

Select the App ID to enable.
Turn ON the ACTIVE toggle switch.

Click Save.
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4. Create a Screen Inside the Module

Use the Modules and Screens menu to create different screens and as many required for the module
like search, list, or detail screen.

To create a screen:
1. Click Modules and Screens on the left panel.

==
Click the Create button next to the search field.
In the Create Modules & Screens section, enter or select the module name in the Module
Name field. For example, ISSUESLIP.
Enter or select the screen name in the Screen Name field. For example, ISLIPC_LIST.
Enter the description in the Module Description field.
Enter the description in the Screen Description field.
Fill the other required details.
Click Create.
. Select the Customizing Request in the Assign Transport Request window.
10. Click Submit.
You can see the created screens at the left side section for the module.

wn
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INNOVAPPTIVE (®)
< mWorkOrder s/ L L &3 ®
Modules & Screens Edit Modules & Screens
Q + T
Screens Filters o
Module Name™ ISSUESLIP o
Defaults Module Issue Slips v
St ISLIPC_LIST il
Filters
Screen
I Module Description Issue Slips
Tirrs Module |SSUESLIP Screen Description Issue Slips Create List Screen
Screen ISLIPC_LIST
Performance Module Desc Issue Slips Support Ul Fields. a
Localization Screen Desc Issue Slips Create List Screen
Use Variant OFF
> Modules and Screens Module ISSUESLIP
Screen ISLIPC_DETAILS Get RFC <]
B Dynamic Forms w Module Desc Issue Slips
Screen Desc Issue Slips Create Details Sc... PostRFC [¥a]
Deactivate Forms
Module ISSUESLIP 2
GIS Maps Screen ISLIPD_LIST CeLBAN
Module Desc Issue Slips o
2 Color Coding Screen Desc Issue Slips Display List Screen FrEEn
EEElE Module ISSUESLIP Entity Set @
Push Notifications Screen ISLIPC_CNF_DETAILS
Module Desc Issue Slips Entity Type
Attachment Config Screen Desc Issue Slips Create Confirm D...
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5. Configure Screen Elements

You can see the newly created screen in the Screens section and can add the elements or
components inside the sections such as Header, Body, and Footer required for the screen based on
the screen design, which is displayed in the application.

Use the Screens menu to configure screen elements like custom tabs, list view, buttons, or navigation
icon, etc.

5.1. Header
Add Home button in the Header section to go back to the Dashboard or Home screen.

in Progress

My Slips

Q Search B372B6 EMERGENCY
Description: Change the conveynor belt

2 items Reservation Mo.: 1223871

837286 EMERGENCY [0 selectall

Description: Change the conveynor belt

Reservation No.: 1223811 ooio Material: 400-421 Adjustment nuts b

Order Starts: 07.29.22 1 day left Outstanding Oty: 100 PC

Plant: 1000-1 Avallable Gry: 100 PC

Companents: 3

3 Outstanding * 0 Pending Approval ® O Approved Required Qty: e 100 PC

B372180 1EDI Approved Qty: 0 PC

Description: Change filter candles in purifier ssue Slips:

rvation No.: 1223809

r Starts: 08.18.22 18 d o020 Material: 100-15mm xenon ballbearings ?
’ = 10001 D Gutstanding Qty: 100 PC
Companents: 1 Available Qty: 100 PC

0 Quistanding * 0 Pending Approval « 1 Appr
Appraved Qty: 0 PC

|ssue Slips: --

onao Material: 5em Valves ?
[ outstanding Qty: 100 PC
Available Qty: 100 PC

Create Issue Slip

To add a home button:

1. Click Screens on the left panel.

+
2. Click the Add icon next to the search field and click Create Screen.

&

You can also click the Copy button on the details pane of an existing Screen
configuration to populate the properties in the Create Screen section.

3. Inthe Create Screen section, enter the following information:
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Field Name

Value

Module

<Required Dynamic Module>

Screen <Required Screen>
Screen Type <List Screen>
Screen Area <Header>

Element

<Left Button>

Element Type

<Home Button>

Ul Label

<Required Name>

Ul Position

<Required Position>

Action

<Required Action>

Action Type

<Required Action Type>

Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

4. Click Create.

Z5 INNOVAPPTIVE

Home Screens
Scoping

= Screens Filters
Defaults Module
Fitters Screen

Searches
ScreenType

Extensions
Element

Module
Screen

Performance
Localization ScreenType

Modules and Screens Element

Madule
Dynamic Forms -
Screen
ScreenType
Deactivate Forms we
Element
= Mape Module
3 Color Coding sereen
ScreenType
® Barcode Layout
Element
Push Notifications Module
Screen
Attachment Config ScreenType

Issue Slips Create List Scre:

LISTSCREEN

LEFTBTN
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LEFTBTN
ISSUESLIP

ISLIPC_LIST
LISTSCREEN

TAB
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LISTVIEW
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

mWorkOrder
Edit Screen
Q + T
Module Name" Issue Slips
Screen Name™ ISLIPC_LIST
en -
Sereen Type” List Screen
Screen Area” Header
Element” Left Bution
Element Type™ Home Button
0
Sequence No
Ul Label Home Butto
Sub Title
ON
® Ul Position ft
Action
on () Action Type GET
Stvie [I0S"{"ICON""ea2b" "SELECTEDICON":""

"
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Z5 INNOVAPPTIVE mWorkOrder /7 1L L& ® 0

Home Screens Action Type GET b
Q + p
Scoping style {710S":{"ICON""ea2b","SELECTEDICON""," | €@
Sceers Filters
o Horizontal v
+ Defaults Module Issue Slips v
P
Data Provider @
Y Fiters Screen Issue Slips Create List Screen v
DP Key
B Semrches ScreenType LISTSCREEN )
& Extensions Hemeat LEFTBTN
g Parent Data Provider
& Potrene Module ISSUESLIP
Screen ISLIPC_LIST At on Q)
M Localization ScreenType LISTSCREEN
=
f8 Modules and Screens Element LEFTBTN Form Name «a
Module ISSUESLIP =
Dynamic Forms v Screen ISLIPC_LIST . UlLabel
v g ScreenType LISTSCREEN
eactivate Forms Ul Label
Element TAB
IS Maps Module ISSUESLIP m
Color Coding Screen ISLIPC_LIST
ScreenType LISTSCREEN
Barcode Layout
Element LISTVIEW
Push Notifications Module ISSUESLIP m “ @ o ox
Screen ISLIPC_LIST
Attachment Config ScreenType LISTSCREEN

5.2. Body

Configure elements like Tab, List View, Line Item details in the Body section.

5.2.1. Tab
Add Tab to display List and Detail view.

My Slips

837286 EMERGENCY
Description: Change the conveynor belt

2 ltems Reservation No.: 122381

837286 EMERGENCY O Al

Description: Change the conveynor belt

Reservation No.: 1223811 ooio Material: 400-421 Adjustment nuts b

Order Starts: 07.29.22 1 day l=ft
Plant: 1000

Compaonents: 3

(100 PC

i guired Qty: &) 100 PC

3 Outstanding » 0 Pending Approval » O Approved

8372180 1EDH

o020 H]
O
0 Owistanding * O Pending Approval

Appray
|ssue S

o030 Material: Sem Valves »

|:| Cutstanding Gty 100 PC

Available Qty: 100 PC
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To a add tab:

1. Click Screens on the left panel.

=
2. Click the Add

icon next to the search field and click Create Screen.

3. Inthe Create Screen section, enter the following information:

Field Name Value

Module <Required Dynamic Module>
Screen <Required Screen>
Screen Type <List Screen>

Screen Area <Body>

Element <Tab>

Element Type <Line Item Tab>

Ul Label <Required Name>

Ul Position <Required Position>
Action <Required Action>
Action Type <Required Action Type>

Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

4. Click Create.
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Home Screens

Z5 INNOVAPPTIVE mWorkOrder

7L L eaa®d

Edit Screen c
Scoping ajl*| ¥
Filters
Screens Module Name™ Issue Slips v
Module Issue Slips ~
e S ISLIPC_LIST
Filters Screen Issue Slips Create List Screen v
Screen Type* List Screen v
Searches ScreenType LISTSCREEN
- Body v
Extensions Screen Are
Element LEFTBTN
Performance Module ISSUESLIP o — Tab v
Screen ISLIPC_LIST
Localization ScreenType LISTSCREEN Element Type" Line Items Tab v
Modules and Screens Element LEFTBTN 0
_ Module ISSUESLIP = R
RS Screen ISLIPC_LIST .
Ul Label Workerders
ScreenType LISTSCREEN
Deactivate Forms
TAB Sub Title
GiS Maps 1SSUESLIP
Golor Coding ISLIPC_LIST Ul Position Left M
LISTSCREEN
P
Barcode Layout Action @
Element LISTVIEW
Push Notifications Module ISSUESLIP JRecion Ty GET v
Screen ISLIPC_LIST
Attachment Config ScreenType LISTSCREEN Fea]
Stvle
>3
ZZ INNOVAPPTIVE mWorkOrder /
Home Screens style @
Q + T
Scoping Layout Horizontal v
Screens Filters
e Pridar WORKORDERS ]
Defaults Module Issue Slips v
: DP Key
Filters Screen Issue Slips Create List Screen v %
Seacies ScreenType LISTSCREEN Parent Data Provider
Extensions
Element LEFTBTN aive O
Barbmance Module ISSUESLIP fox O)
Screen ISLIPC_LIST Pe— 2]
Localization ScreenType LISTSCREEN
Modules and Screens Element LEFTBTN Ul Label
Module ISSUESLIP =
DI Screen ISLIPC_LIST el

ScreenType LISTSCREEN

Deactivate Forms
Element TAB

Module ISSUESLIP
Screen ISUPC_LIST
ScreenType LISTSCREEN

GIS Maps
Color Coding

Barcode Layout
LISTVIEW

ISSUESLIP
ISLIPC_LIST
LISTSCREEN

Element

Push Notifications Module

Screen

Attachment Config ScreenType

5.2.2. List View

Add List View in the Tab to view required data in a List view.
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in Proaress
My Slips
Work Orders {2) |zsued Slips (0}
Search 837286 EMERGENCY
Description: Change the conveynor belt
2 items Reservation Mo.: 1223811
837286 eMERGENCY | [ Selectall
scription: Change the conveynaor belt
2
¢ left
Compaonents: 3
3 Outstanding * O Pending Approval ® O Apprc
8372180
Description: Change filter candles in purifier
23809
on20 Material: 100-15mm xenon ballbearings >
O ing Gty: 100 PC
anents: 1 Available Oty: 100 PC
0 Outstanding * O Pending Approval *
Approved Qty: 0 PC
|55
on3o Material: 5em Valves >
O outstanding Qty: 100 PC
Available Qty: 100 PC
Create Issue Slip

To add a list view:

1. Click Screens on the left panel.

+

2. Click the Add icon next to the search field and click Create Screen.

3. Inthe Create Screen section, enter the following information:

Field Name Value

Module <Required Dynamic Module>
Screen <Required Screen>

Screen Type <List Screen>

Screen Area <Body>

Element <List View>

Element Type <Search List View>

Ul Label <Required Name>

Ul Position

<Required Position>

Action

<Required Action>

Action Type

<Required Action Type>
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Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

4. Click Create.

Home

Scoping

Screens

Defaults

Filters

Searches

Extensions

Performance

Localization

Modules and Screens

® ® 3P % E <« % I

Dynamic Forms

Deactivate Forms

GIS Maps

Color Coding
Barcode Layout
Push Notifications

Attachment Config

Home
Scoping
Screens
Defaults
Filters
Searches
Extensions
Performance

Localization

# 3 P % B < »

Modules and Screens

®

Dynamic Forms v

Deactivate Forms

GIS Maps

Color Coding

Barcode Layout

Push Notifications

Attachment Config

Z5 INNOVAPPTIVE

Screens

Filters

Module

Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Z INNOVAPPTIVE

Screens

Filters

Module

Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Element
Module
Screen

ScreenType

Issue Slips

ssue

ssue

Issue

Slips Create List Screen

LISTSCREEN

LEFTBTN
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LEFTBTN
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

TAB
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LISTVIEW
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

Slips

Slips Create Lis

LISTSCREEN

LEFTBTN
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LEFTBTN
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

TAB
ISSUESLIP
ISLIPC_LIST
LISTSCREEN

LISTVIEW
ISSUESLIP
ISUPC_LIST
LISTSCREEN

5.2.3. Line Item Detail View

mWorkOrder

Module Name*

Screen Name™

Screen Type"

Screen Area”

Element"

Element Type"

Sequence No

Ul Label

Sub Title

Ul Position

Action

Action Type

mWorkOrder

Action Type

Style

Layout

Data Provider

DP Key

Parent Data Provider

Active

Form Name

Ul Label

Ul Label

Edit Screen

Issue Slips
ISLIPC_LIST
List Screen
Body

List View

Search List View

Search

Center

ISLIPC_LIST

GET

Horizontal

s L L e&m®0
(E

@

-

71 L& 00

@

(4]

@

Add a Detail View in the Tab to view details of a required line item when you click on it.
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EMERGENCY

ion: Change the conveynar belt
223811
1day left

0 Pending Approval = O Apor

3 Outstanding *

8372180
Descripti

2rils: 1
0 Qutstanding * O Pending Approval »

In Progress

My Slips

Waork Orders {2) |zsued Slips (0}

837286
Description: Change the conveynor belt

Reservation No.: 1223811

ooz Material: 100-15mm xenon ballbearings
ing Qty: 100 PC

ble Qty: 100 PC

Appro
Iss)

| Qty: 0 PC

onio Material: Sem Valves
[0 outstanding Gty: 100 PC
Available Qty: 100 PC

EMERGENCY

To add a line item detail view:

1. Click Screens on the left panel.

+
2. Click the Add

Create Issue Slip

icon next to the search field and click Create Screen.

3. Inthe Create Screen section, enter the following information:

Field Name

Value

Module

<Required Dynamic Module>

Screen

<Required Screen>

Screen Type

<Detail Screen>

Screen Area <Body>

Element <List View>
Element Type <Check List View>
Ul Label <Required Name>

Ul Position

<Required Position>

Action

<Required Action>

Action Type

<Required Action Type>
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Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

4. Click Create.

Z INNOVAPPTIVE

Home Screens

mWaorkOrder s 1 L &m0
Edit Screen G

Scoping a + v
Filters
[2 Screens Module Name* Issue Slips v
Module Issue Slips ~
*  Defaults S ISLIPC_DETAILS
Y Filters Screen Issue Slips Create Detalls Screen v
Sereen Type* Detail Screen v
[E Searches
Element LISTVIEW Er— e Body v
& Extensions Module ISSUESLIP
e Screen ISLIPC_DETAILS S List View -
ScreenType DETAILSCREEN
Locallzation ¢ ist View v
L Element LISTVIEW Element Type:  C1ECK LIS VIE
@ Modules and Screens Maodule ISSUESLIP — ,
Screen ISLIPC_DETAILS : Sequence No
® Dynamic Forms w ScreenType DETAILSCREEN
AN Labet Details Screen
Deactivate Forms Element LISTVIEW
Maodule ISSUESLIP p— Sub Title
GIS Maps Screen ISLIPC_DETAILS
o ScreenType DETAILSCREEN 1% Pasition Center v
Element BTN th
Barcode Layout Action
Module ISSUESLIP m
Push Notifications Screen ISLIPC_DETAILS GET .
- Action Type
ScreenType DETAILSCREEN
Attachment Config a8
Stvle Eal
ZS INNOVAPPTIVE T
=2 mWorkOrder s 1 L
Home Screens Style @
Qi+ "
Scoping Empot Horizontal v
Screens Filters
Data Provider ISLIP_WODETAILS @
Defaults Module Issue Slips v
DP Key
Fiters Screen ssue Slips Create Details Screen v g

Searches

Extensions

Performance

Localization
Element

Modules and Screens Module
Screen
Dynamic Forms v ScreenType
Deactivate Forms Element
Module
GIS Maps Screen
. ScreenType
Color Coding
Element
Barcode Layout
Module
Push Notifications Screen
ScreenType

Attachment Config

5.3. Footer

Parent Data Provider
LISTVIEW

ISSUESLIP
ISLIPC_DETAILS
DETAILSCREEN

Active

Form Name @
LISTVIEW
ISSUESLIP Ul Label
ISLIPC_DETAILS
DETAILSCREEN Ul Label

LISTVIEW
ISSUESLIP
ISLIPC_DETAILS
DETAILSCREEN

BTN
>
JENE - B
ISSUESLIP Pon O “ i

ISLIPC_DETAILS
DETAILSCREEN

Add Create Issue Slip button in the Footer to create or add issue slip details.
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in Progress

My Slips

Work Orders {2) Issued Slips: (0}

EMERGENCY

ents: 3

3 Outstanding * O Pending Approval ® © Apoic

8372180
Description: Change filter candles in purifier

3809

To add a create button:

1. Click Screens on the left panel.

+
2. Click the Add

837286
Description: Change the conveynor balt

Reservation No.: 1223811

o020 Material: 100-15mm xenon ballbearings
[0 outstanding Qty: 100 PC
Available Qty: 100 PC

Qty: 0 PC

onio Material: 5cm Valves
[ outstanding Qty: 100 PC
Available Oty: 100 PC

EMERGENCY

Create lesue Slip

3. Inthe Create Screen section, enter the following information:

icon next to the search field and click Create Screen.

Field Name

Value

Module

<Required Dynamic Module>

Screen

<Required Screen>

Screen Type

<Detail Screen>

Screen Area <Footer>
Element <Button>
Element Type <Create>
Ul Label <Required Name>

Ul Position

<Required Position>

Action

<Required Action>

Action Type

<Required Action Type>
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Data Provider <Required Data Provider>

DP Key <Required DP Key>

Parent Data Provider <Required Parent Data Provider>

4. Click Create.

= I
S INNOVARPTIVE mWorkOrder s 1L L e&s @0
Screens Edit Screen c
Scopi Q + v
Screens Filters e — Issue Slips v
Madule Issue Slips ~
Defaults A ISLIPC_DETAILS
Filters Screen Issue Slips Create Detalls Screen v -
Screen Type* Detail Screen v
Searches
Element LISTVIEW F
Screen Area® ooter v
Extensions Module ISSUESLIP fon O)
Screen
S cree ISLIPC_DETAILS I Bution .
ScreenType DETAILSCREEN
Localization . Create v
Element LISTVIEW D
Modules and Screens Module ISSUESLIP =
Screen ISLIPC_DETAILS : Prompt Alert
Dynamic Forms ScreenType DETAILSCREEN
Sequence No 0
Deactivate Forms Element LISTVIEW
Module ISSUESLIP ‘e Create Issue Slip
GIS Maps Screen ISLIPC_DETAILS
ScreenType DETAILSCREEN
Color Coding N Bt
Element BTN
Barcode Layout o Right v
z Module ISSUESLIP b
Push Notifications LB redrg 1 Action ISLIPC_CNF_DETAILS Ll
DETAILSCREEN
Attachment Config
Action Tvoe hd
P %
2 INNOVAPPTIVE mWorkOrder 7 1 L & ® 0
Home Screens
S a + v Action Type
P
Saeens Filters Style <
Defaults Module Issue Slips v Layout v
Filters Screen Issue Slips Create Detalls Screen v Data Provider @
Searches
Element LISTVIEW oetay
Extensions Module ISSUESLIP Clo £
Ser
Performance P IOLIPC.DETAILS Parent Data Provider
ScreenType DETAILSCREEN
Localization .
Element LISTVIEW nee  CHO®
Modules and Screens Module ISSUESLIP = s
Screen ISLIPC_DETAILS Form Name =
Dynamic Forms v ScreenType DETAILSCREEN
Ul Label
Deactivate Forms Element LISTVIEW
Module ISSUESLIP ; Ul Label
GIS Maps Screen ISLIPC_DETAILS
ScreenType DETAILSCREEN
Color Coding

Element BTN

Barcode Layout
Module ISSUESLIP

Push Notifications Screen ISLIPC_DETAILS

ScreenType DETAILSCREEN a8
Attachment Config @ .
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6. Define Extensions or Fields

Add extensions for the body elements to show them in the screen and its data elements like drop
down values or collections to be called in the extension.

Use the Extensions menu to create and map a new field from the SAP system.
To configure extensions fields for screens:

1. Click Extensions on the left panel.

+
2. Click the Add

icon next to the search field.

3. Inthe Create Extension section, enter the following information:

Field Name Value

Module <Required Dynamic Module>
Screen <Required Screen>

Category < Category >

Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

Section Name

< Required Section Name>

Section Position

< Required Section Position>

Source Type

< Required Source Type>

Field Name <Required Field Name>
Ul Label <Required Label Name>
Field Type <Required Field Type>

4. Click Create.

18 | Add Module for mWorkOrder




Z> INNOVAPPTIVE

Z> INNOVAPPTIVE

7 Extensions

_ Extensio a + T
I=
Il Filters
- Module OPERATOR ROUNDS ~
Y Screen NOTIF_CREATE v
a

Category ~
*

Status v

Module OPERATOR ROUNDS
Screen NOTIF_CREATE
Table / Entity Set NINVMWO/BAPI_OPROL
Field QMART
Ul Label Notification Type
Module OPERATOR ROUNDS
] Screen NOTIF_CREATE
Table / Entity Set /INVMWO/BAPI_OPROL
8 Field SHORT_TEXT m

mWorkOrder

Source Type

App ID

Table / BAPI Name

Table / BAPI Description

Field Name™

Field Description

Parameter Type

Post BAPI Name

Post BAPI Field Name

Ul Label®

Field type*

Load More

BAP| Name

[INVMWO/BAPI_OPROUND_NOTIF_CRE

Notification create for each roundid

QMART

Import

LS_NOTIFCREATE

Notification Type

ID - Input Dropdown

OFF

@

]
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7. Postings

Add the Action Type and Data Provider values to the elements like Submit or Save buttons, these are
added in the Footer section. When you click the buttons, the filled data is posted in the application
based on the selected values in Action Type and Data Provider.

To add Action Type and Data Provider values for the elements:

1. Click Screens on the left panel.

=
2. Click the Add icon next to the search field and click Create Screen.

.ll'!.

i
You can also click the Copy button on the details pane of an existing Screen
configuration to populate the properties in the Create Screen section.

3. Inthe Create Screen section, enter the following information:

Field Name Value

Module <Required Dynamic Module>
Screen <Required Screen>
Screen Type <List Screen>

Screen Area <Header>

Element <Left Button>

Element Type <Save Button>

Ul Label <Required Name>

Ul Position <Required Position>
Action <Required Action>
Action Type <Required Action Type>

Data Provider

<Required Data Provider>

DP Key

<Required DP Key>

Parent Data Provider

<Required Parent Data Provider>

4. Click Create.
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Screens
Search Screen Configurations Q + h
Filters
Module OPERATOR ROUNDS ~
Screen TASK_DETAILS v
Element LABEL
Module OPERATOR ROUNDS
Screen TASK_DETAILS m
ScreenType LINEITEMDETAILSCREEN

Element BTN
Module OPERATOR ROUNDS

Screen TASK_DETAILS O
LINEITEMDETAILSCREEN

ScreenType

Element PROGRESSBAR

Ul Position

Action

Action Type

Style

Layout

Data Provider

DP Key

Parent Data Provider

Active

Form Name

center

POST

{"108"{"ICON":"""SELECTEDICO!

Horizontal

TASK _POST
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8. Call Ul Services to Display Data in Application

For all Get & Post, call only DynamicExtensionsCollection with proper Data providers & KeyProviders
(Filters based on data).

For example,

http://ngwa.innovapptive.com:8000/sap/opu/odata/INVCEC/RACE_SRV/DynamicExtensionCollectio
n?$filter=APPNAME%20e0%20%27 MWORKORDER%27%20and%20MODULENAME%20eq%20%270P
ERATOR%20ROUNDS%27%20and%20SCREENNAME%20e0%20%27MY ROUNDS%27%20and%20DA
TAPROVIDER%20e0%20%27MYROUNDSLIST%27

For URL with KEY providers

http://ngwa.innovapptive.com:8000/sap/opu/odata/INVCEC/RACE_SRV/DynamicExtensionCollectio
n?$filter=APPNAME%20eq%20%27 MWORKORDER%27%20and%20MODULENAME%20eq%20%270P
ERATOR%20ROUNDS%27%20and%20SCREENNAME%20e0%20%27TASK DETAILS%27%20and%20
DATAPROVIDER%20eq%20%27TASK INFO%27%20and%20KEYVALUES%20e0%20%27IV_OP_ROUN
D 1D:2011334;IV_EQUIP ID::IV_TPLNR ID:DL-EH-02-P04%2

This way you can fetch the data and display it Ul.

9. Document Revision History

S. No | Document Version Date Created Change History

1. 1.0 06 September 2022 2208
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